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Chapter 1 – Getting Started 
 
 

Introductions 

 
Please share the following information with your classmates so that we can get to 
know each other better: 
 

 Name 
 Title and Time in Your Current Position 

 
 

General Housekeeping 

 
 Please put your cell phones on vibrate to minimize classroom distractions. 
 You are encouraged to write down and submit questions that the instructor 

cannot answer. Your instructor will research your questions so that they 
can be addressed at a later time. 

 Your instructor will set break times throughout this course, and the class 
will begin promptly at the agreed upon start time. 

 



Chapter 1 – Getting Started 
 

 2  

 

Overview of IBM Cognos 10 
 
Components and license roles in IBM Cognos 10 Business Intelligence (BI) tool 
suite: 
 

 
 

IBM Cognos Component Use 
Metric Studio Monitor performance against benchmarks and priorities 
Event Studio Invoke tasks, and track events and processes 
Report Studio Create managed reports – most advanced studio 
Query Studio Create ad hoc reports 
Analysis Studio Explore and analyze data 
Business Insight 
Advanced 

Author reports with relational or dimensional data and analyze data in lists, 
crosstabs, and charts 

Business Insight Build and use sophisticated, interactive dashboards using Cognos content as 
well as external data sources 

IBM Cognos Viewer View results of all reports, queries, and analyses. IBM Cognos Viewer shows 
report output after a user has interacted with any prompts 

IBM Cognos Connection Access all data available through IBM Cognos 
Framework Manager Create and publish metadata models on which reports are based. Business 

Insight Advanced, Query Studio and Report Studio can report from all models. 
All studios can report from dimensionally modeled relational data (which can be 
created in Framework Manager) 

Transformer Create and publish cubes on which reports are based. Business Insight 
Advanced, Query Studio, Analysis Studio, and Report Studio all can report from 
cubes 

Metric Designer Create scorecards and metrics 
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Let’s take a closer look at three of the key components you use to model, 
access, and analyze your data. 
 
 

What is Framework Manager? 
 
Framework Manager is the metadata modeling tool that allows you to model 
relational data. This is a client application (not web-based), as is Transformer, 
but all other components listed previously are web-based. 
 

 
 
The result of a Framework Manager model is a package(s). When packages are 
published, this is the first time a report developer can create a report against that 
data using either Business Insight Advanced or Report Studio.  
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What is IBM Cognos Connection? 
 
IBM Cognos Connection is the portal interface to all of the functionality available 
in IBM Cognos 10. It is a web application for viewing, creating, and managing 
queries and reports. In the portal, you can: 
 

 View public reports. 
 Create and run reports. 
 Perform administrative tasks, such as scheduling and distributing reports. 
 Organize data by creating entries and storing the entries in folders. 
 Personalize the portal to meet your needs. 

 
 

Business Insight Advanced or Report Studio? 
 
Determining whether to use Business Insight Advanced or Report Studio to 
analyze your data and develop reports depends on a number of factors, in 
addition to your IBM Cognos licensing. 
  
 
 

 
 

Business Insight 
Advanced 

 
 

Business Insight Advanced is an easy-to-use authoring tool with 
which you can quickly create queries from the data stored in 
your database or from external data without having the skills of a 
professional report writer. Business Insight Advanced can also 
be used for exploring information in multiple dimensions and for 
deep comparative analysis, enabling business users to get fast 
answers to business questions by trending or analyzing your 
organization’s information assets. 

 Limited prompting is available for report design. 
 Send reports to a professional user for further 

development in Report Studio 
 

 

With Report Studio, you can create advanced reports with more 
flexibility than any other studio available in Cognos. Report 
Studio reports can contain charts, maps, lists, repeaters, or any 
other available report types using static data from relational or 
multi-dimensional data sources. 

 Use for a more official, published report versus a query or 
analysis for internal use. 

 Knowledge of SQL fundamentals is helpful. 
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Relational or Dimensional Data? 

 
Business Insight Advanced works with both relational and dimensional data. 
Relational data is structured like tables and columns in a database. Data is 
available real-time. 
 
IBM Cognos presents dimensional data in one of two ways: 
 

 Dimensionally Modeled Relational (DMR) packages that have been 
modeled in Framework Manager, or  

 PowerCubes that have been defined in the IBM Cognos client-based 
Transformer application and published as a package. 

 
Queries or analyses using DMR packages access the data source each time a 
query is launched and reflect the most current data. PowerCubes are static, 
which means that they must be updated periodically, but allow for much faster 
retrieval of data. 
 
The two elements required to build a DMR package or a cube are “dimensions” 
and “measures”.  
 
Dimensions are the hierarchies or levels by which information can be 
aggregated. Consider your organizational chart – an employee may work for a 
Division, which rolls up to an Entity. 
 
Another common example of a dimension is time. A typical illustration of a time 
rollup may look as follows: 
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Measures represent quantifiable results in terms of numeric data. Examples of 
measures include: 

 dollar amounts, i.e., Net Amount 
 counts, i.e., Account Count 
 calculations and measurements, i.e., Travel Expense Average Amount 

 
In general, dimensions answer the questions of “who, what, when, where, and 
how”. Measures answer the question of “how much”. 
 
From a well-designed dimensional data source, users can easily and quickly 
create reports that can be customized to answer questions about specific 
performance indicators (measures) at levels of detail that reflect the desired 
perspective (dimension).  
 
 
 
NOTE 

When an end user asks for a report, it’s often phrased like this:  
 
“I’d like to see incurred actuals by year for a particular division.” 
 
A good rule of thumb: any data element before the word “by” is a 
measure while any data element after the word “by” is a dimension. 
Anything after the word “for” is typically a filter. 

 
 
 
 
NOTE 

For the first half of this course, we focus on reporting with relational 
data. In the second half of the course, we report against the UCAR 
TM1 Cube Data Training cube.  
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If you are reporting against a cube, the name of the package usually ends in the 
word “Cube”. For example, a package may be named “Training Data Cube” 
versus “Training Data”. 
 
Once you have launched an IBM Cognos studio, you see a difference in the look 
of the packages in the Insertable Objects window.  
 
Cube objects consist of Dimensions, Members, and Measures.  
 
Relational packages consist of Namespaces, Query Subjects, and Query Items 
as shown:  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Query Subject 

Query Item 

Namespace 

Dimension 

Member 

Measure 
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NOTE 

The icons used to denote Dimensions and Levels differ depending 
on which IBM Cognos studio you are using. 

 
 
 
 
 
 
Step-By-Step 
 

Getting Started 

 
 
 
 

1. From a web browser, type the following URL: 
https://fagrand.fanda.ucar.edu/ibmcognos. With single source 
authentication for your environment, the system should recognize your 
CIT account and grant you access to IBM Cognos. 

 
 
The Welcome Page may appear, with links to IBM Cognos Connection (IBM 
Cognos content) and the IBM Cognos modules available to you. Note that you 
have the option to uncheck the Show this page in the future box in order to 
bypass this page. 
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Understanding IBM Cognos Connection 
 
Once you have successfully logged into IBM Cognos, or selected IBM Cognos 
content from the Welcome Page, the portal appears. This is the primary way to 
access Business Insight Advanced and the associated reports and reporting 
tools. The web interface means that nothing needs to be maintained on the 
user’s desktop. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 
 
 
 
NOTE 

The reason the portal is the primary way to access IBM Cognos 
Business Insight Advanced is that developers can create hyperlinks 
to reports directly from another application or web page. This 
bypasses IBM Cognos Connection after authenticating the user. 

 
 

All reports available 
to more than one 
person exist here 

Personalize and 
manage your 
reports here 

If there are more than 15 
entries on a page, you’ll need to 

page down to see everything 

Report 
development 

interfaces based on 
security privileges 

Your personal 
workspace 

Your user name (If 
you’ve authenticated) 
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Step-By-Step 
 

Navigating in IBM Cognos Connection 

 
 
 
 

1. Navigate to the IBM Cognos Training > Business Insight Advanced 
Training folder. 

 

 
 

2. Click on the IBM Cognos Training folder link to navigate back up. 
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3. Click on the My Folders tab to navigate to your personal work space. 
 

 
 

4. Create a personal folder in the My Folders tab. 

a. Click on the New Folder  icon. 
b. Type “Business Insight Advanced Training” in the Name box. 
c. Click Finish. 

 
 
Folder Tools 
 
As you navigate through the Public Folders and My Folders tabs, a Toolbar of 
available options displays. The Toolbar shows the actions that can be performed 
in the portal. They are described below. 
 

 
 
 

 Refresh the portal Create a page 

 
Show entries in a list  Cut the selected entries 

 Show detail information for each entry Copy the selected entries 

 Create a folder Paste clipboard contents to the current location 

 Create a package Delete the selected entries 

 Create a dashboard Show the properties for the current folder or package 

 Run multiple reports Set the order for folders or entries 

 Create a URL to an external file or web site  
 
 
 
NOTE 

These icons vary based on licensing permissions and only appear 
where they are relevant. On some pages they are not displayed. 
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Step-By-Step 
 

Running a Report 

 
 
 
 
To ensure that we do not make unwanted changes to the original report, let’s 
save a copy of the report from Public Folders to the Business Insight Advanced 
Training folder that we created earlier in your My Folders tab.  
 

1. Navigate in IBM Cognos Connection to Public Folders, and then use the 
Search feature in IBM Cognos Connection instead of the page scrollers 
and basic navigation. 

2. In Public Folders, click on the down arrow beside the Search box and 
select Name field.  

 

 
 

3. Type “account” in the Search box and click the Search icon. 
 

 
 

4. Check the box next to the Account Postings by Date Range report and 

click on the Copy  icon in the top right corner of the page. 
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NOTE 

Click the Properties icon in the search result to find the location 
of that report specification. 

 
 

 
 
 

5. Click on the Return  icon and navigate to My Folders > Business 

Insight Advanced Training and click on the Paste  icon in the 
Toolbar. 

6. Review the report options available in the Actions menu. 
 

 
 

 Set/modify properties Create a report view (shortcut) 

 Run with options Schedule recurring jobs 

 Open the report in Report Studio All available report options 
 

7. Click on the Run with options  icon under Actions. 
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8. Select any options needed for this report execution. For now, select HTML 
and click Run. 
 

 
 
 
 
NOTE 

Developers can specify a default format in the properties of any 
report. Selecting the PDF option (as the default or at runtime) 
requires Adobe Reader on the user’s desktop. 

 
 

   

HTML 
PDF 
EXCEL 2007 
EXCEL 2002  
Delimited text (CSV) 
XML 

One time scheduling 
Distribution options 
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If the report has a prompt page, you see it in HTML as shown below, regardless 
of the report output format you select (prompting is discussed in more detail 
later). 
 

9. Select December 1, 2010 as the From date and December 31, 2010 as 
the To date. Click OK. 
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Your report executes and displays the results in IBM Cognos Viewer. This is the 
interface used to display reports regardless of the interface used to develop the 
report (Business Insight Advanced or Report Studio). 
 

 
 
 
 

Clicking on the report name link in IBM Cognos Connection 
displays the report as it was last run; hence it may or may 
not display the most current data. It is more consistent to 

always select Run with options  from the Actions menu.  
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Understanding IBM Cognos Viewer 
 
While viewing a report in IBM Cognos Viewer, you can perform many actions that 
are available from the Run with options and the Run with advanced options 
pages. 
 

 
 
The Keep this version drop-down box provides options to email or save the 
report. Saving the report as a Report View is like creating a “shortcut”. 
 

 
Run the report again with the blue arrow:  

Drill down  and Drill up  allow users to navigate through dimensionally 
modeled data (Note: This report is not using dimensionally modeled data- thus 
the buttons are inactive). 
 

Drill-thru  takes users to a related report. 
 

The View options are available in another drop-down box:  
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The Add this report drop-down box allows users to quickly add the report to My 
Folders or My Bookmarks 
 

 
 

You can open the report in Report Studio by clicking on the triangle  

Clicking on the arrow  returns you to the same folder.  

Clicking on Home  returns you to IBM Cognos Connection home.  

Clicking on the Browser’s X button  closes IBM Cognos Viewer and IBM 
Cognos Connection! 
 
 
 
NOTE 

When using IBM Cognos Viewer in HTML output, always check to 
see if there is a Page Down option in the bottom left of the report. 
There may be more data that isn’t displayed on the initial page. 

 

 
 
 
 
 
Step-By-Step 
 

Viewing Public Reports 

 
 
 
 

1. Click on the Home  icon to return to IBM Cognos Connection. 
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2. In Public Folders, click on the down arrow beside the Search box and 
select Name field.  

 

 
 

3. Type “Training” and press Enter or click the Search  icon.  
 

 
 

4. From the search results, navigate to the Business Insight Advanced 
Training > Chapter 1 folder. There is a sample report called Report View 
of Account Postings by Date Range. Click on the output versions as 
shown below. 

 

 
 
 

Note there are three output formats, all with the same data. This is an option 
chosen by the creator of the report view. 

 

 
 

5. Click the Close button. 
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Demo 
 

Scheduling Reports 

 
 
 
 
The instructor now demonstrates how to click the Run with options button on that 
same report to schedule it to run. 
 

 
 
 
 
 
 

Users can schedule their report to run in the background now or at some date / 
time in the future on any report. This is useful for longer running reports. 
 
 
 
Step-By-Step 
 

Personalizing the Portal 
 
 
 

1. Click on the My Area Options drop-down arrow in the upper right section 
of the portal: 
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2. In My Preferences, you can personalize your portal view with the 
following options. Please set the Number of entries in list view property to 
“25”, and the Separators in list view drop-down to Alternating 
backgrounds and click OK. 

 

 
 
Note the alternating backgrounds now in this short list of reports. 
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Chapter 2 – Examining a Business Insight Advanced 
Report 

 
In the previous chapter we looked at the three main components of IBM Cognos 
for modeling, accessing, and analyzing data, and became familiar with IBM 
Cognos Viewer to view a report. We start our examination of Business Insight 
Advanced with a more detailed summary of how it differs from Report Studio in 
particular. 
 

How Business Insight Advanced Differs from Report Studio 
 
Our list is not all-inclusive, but should give you a general feel for which module is 
more appropriate given a user’s requirements and/or skills.  

 
 Unlike Report Studio, a Business Insight Advanced developer cannot 

control the type of prompt that is available to consumers – the default 
assigned by Framework Manager is the only option. 

 A Business Insight Advanced developer cannot modify a join 
relationship that has been created in Framework Manager, while 
Report Studio allows this flexibility. 

 Limited conditional formatting is allowed in Business Insight Advanced, 
but it does not offer the same functionality available in Report Studio.  

 
 
 
NOTE 

A report can be created in Business Insight Advanced and easily 
opened in Report Studio for further editing and enhancements. 
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Opening an Existing Report in Business Insight Advanced 
 
IBM Cognos provides several ways to access Business Insight Advanced 
including: 
 

From the Welcome Page: 
 

 
 
From the Launch drop-down at the top of the IBM Cognos Connection 
portal: 
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From the Open with Business Insight Advanced icon from the Actions 
menu in IBM Cognos Connection on a particular report specification: To 

see this option, click on the  icon next to the report, then click on the 
link to Open with Business Insight Advanced. 
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From the Do More  button when you drag the report into a dashboard in 
Business Insight:  
 

 
 
 
 
NOTE 

When you first open a report, you may get the following warning 
screen which means that developers have made a change and the 
report needs to be validated. Click OK to proceed. 

 
 

 
 



Chapter 2 – Examining a Business Insight Advanced Report 
 

 27  

 
 
Step-by-Step 
 
 

Open an Existing Report in Business Insight Advanced 
 
 
 
 
You can open an existing report in Business Insight Advanced to view the most 
current data in the query, to make changes to the report, or to use it as the basis 
of a new report. 
 

1. Navigate to Public Folders > IBM Cognos Training > Business Insight 
Advanced Training > Chapter 2 > Account Postings by Date Range. 
In the Actions menu, click on More and then the Open with Business 
Insight Advanced icon. 
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The Business Insight Advanced interface is displayed. 
 
 
 
 
 
 
 
 

 
 
 
 
 
 
 

Insertable 
Objects 

Properties Pane – shows attributes 
associated with report objects 

Work Area – where 
the report is built 

Page Header/Footer – above 
and below the red line  
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Note that the Insertable Objects pane has 2 tabs: 
 

 
 
 

Source and Toolbox 
 
The Source tab allows the developer to insert items directly from the Framework 
Manager package that was selected. 
 

2. Click on the Source tab to see the different data items than can be 
inserted into a report. 

3. Click on the Toolbox to display all of the special features and formatting 
options that IBM Cognos provides to add functionality and flexibility to your 
reports. 

4. Highlight different items in the report to see the properties for that item 
displayed in the Properties pane. 

 
 

Understanding Business Insight Advanced 
 
While developing reports in Business Insight Advanced, you can perform many 
actions that are available from the Menu bar. 
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5. From the View menu, select Page Design and review the report structure. 
 

 
 
The Page Design option allows you to focus on the report layout. It is best to use 
this option as you are developing queries and until you have determined: 

 The specific fields you want to include in the query 
 The format you prefer for the report 
 How you want to limit the data returned by applying filters 

 
Selecting the Page Preview option gives you a better feel for the content of the 
items you have selected. 
 
Once you are ready to test a report, or to view an existing report, run the report 
with all data by: 

 Selecting your report format from the Run menu. 

 Using the Run Report  icon in the Toolbar.  
 
 
 

Viewing your report using the Page Preview option - before 
you are certain that you have selected the correct data items 
and have applied the appropriate filters - may cause a query 
to run for a long time before displaying results! In addition, 
the results may not be accurate or what you expected to 
see. 
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Step-By-Step 
 

Examining the Query Filters 

 
 
 
 
Continuing from the previous exercise, notice that there is a text box under the 
title of our report that indicates that Filters have been applied to the report:  
 

 
 

1. From the Data menu, select Filters, and then select Edit Filters. 
 

 
 
A new dialog box opens displaying the filters applied to the report. 
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This report has two conditions, both of which must be true.  
 

2. Highlight the first filter and click on the pencil icon to view the filter. 
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The Filter Condition dialog box displays a list of values from which to choose one 
or more values for the report. You can see the selected values for Account 
Number in the right-hand pane. 
 

 
 

Note that the combination of including or excluding values and un-checking the 
Prompt for values when report is run in viewer option is the equivalent of “hard-
coding” a filter in your query. Hard-coding a filter means that the report runs with 
the selected values without asking for input from a user. 
 

3. Click on the Condition down arrow to see that you also have the option to 
NOT show the filter choices.  

 

 
 

4. Click Cancel. 
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5. Next, highlight the Post Date filter and click on the Edit icon.  
 
A Values Range prompt appears, giving the user the option to select dates from 
a Calendar to filter for Post Date. Note that leaving the “Prompt for values when 
report is run in viewer” option checked is what allows the user to select the Post 
Date each time the report is run. 
 

 
 

6. Note the check box at the bottom left of the box. Clicking in this box 
includes missing values. Business Insight Advanced automatically leaves 
out any missing values. Leave the box blank and click Cancel twice to 
return to the report. 
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7. From the Report Actions  menu, select Save As to save this report 
under a new name in My Folders > Business Insight Advanced 
Training.  
 

 
 

8. Verify that the Location is correct – if not; click on My Folders and then the 
Business Insight Advanced Training folder to modify it. 
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9. Return to IBM Cognos Connection by clicking on Exit in the Report 
Actions menu. 
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IBM Cognos and Business Insight Advanced Tips 
 
As you work with IBM Cognos and Business Insight Advanced, keep these tips in 
mind for easier use and better performance. 
 

 It doesn’t work like a browser. IBM Cognos does not fully support the 
functionality of the Internet Explorer browser. For example, you may notice 
that sometimes the Back button works and sometimes you get errors or no 
response at all. For greater Business Insight Advanced happiness, only 
use options visible within the IBM Cognos interface and not in your 
browser. 

 
 Cancel doesn’t really mean Cancel. When you run a report, you might 

notice that Cancel is an option while your report is running. Unfortunately, 
clicking on the Cancel button doesn’t cancel the query and can actually 
contribute to a backlog of data requests if used repeatedly for the same 
report. Unless you plan to change the report in some way before 
resubmitting the query, it is better to wait out the report rather than try to 
interrupt it. As an alternative, you can choose Select a delivery method. 

 
 Navigate to the Bottom for faster performance. Running a long report 

in HTML displays navigation options at the bottom of the screen. If you 
pick Page down, the report needs to re-run. Choose Bottom instead, 
which places the entire report into memory (cache) and allows you to 
more quickly move between pages. 
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Chapter 3 – Creating a Simple List Report 
 
With Business Insight Advanced, you create, view, and run different report types 
to look at data in different ways or to answer different business questions. Report 
styles available in Business Insight Advanced include: 
 
Report Style Description 
List  Shows data row by row 

 Can show each line of detail in a data set 
or group similar items together, eliminating 
duplicate rows (Grouped List Report) 

Crosstab Shows a value at the intersection of each row 
and column 

Chart Shows data in various graphical formats 
Financial A template based on the Crosstab structure 

along with a header and footer. 
 

Understanding Packages 

 
New reports are created by inserting items from a “package” into an empty 
report. Packages are created and “published” from the IBM Cognos Framework 
Manager application. A Cognos package normally groups data from the 
organization’s underlying data sources into smaller, closely related, and logical 
subsets. All of the required relational links are created in the package. The 
Framework Manager administrator has the flexibility to create packages that are 
much more user-friendly than the underlying data for report and query authors. 
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You are working with the UCAR Training package.  
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A list report shows data row by row, or record by record. Many users think of this 
as “detailed data” or “transaction level data”, which is not always the case, 
depending on the data source and the query populating the list report. 
 
 
Step-By-Step 
 

Creating a Business Insight Advanced Report 

 
 
 
 
Let’s create a new list report that lists information about transaction postings for 
selected accounts. 
 

1. To create a simple list report, launch Business Insight Advanced and 
select the UCAR Training package by either selecting it from the Recently 
used packages list, or scrolling through the folders to Cognos > Public 
Folders > UCAR Data Sources > UCAR Training. 
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NOTE 

Until you have created queries of your own, you do not see options 
in the Recently used packages list. 
 
 
 
 
 

2. Choose Create new report. 
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3. Select List and click OK. 
 

 
 
Recall that until appropriate filters have been added to our report, it is more 
efficient to use the Page Design option. 
 

4. From the View menu, select Page Design. 
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5. From the Insertable Objects pane, in the Source tab, navigate to the 
UCAR Training package, CPM Training Data namespace, General Ledger 
namespace, Account query subject, and then expand it: 
 

  
 
To select items for the report you have the following options: 

 Highlight the query subject to select all of the query items in that 
group. 

 Click once to select a single item. 
 Ctrl-click to highlight multiple items. 
 Shift-click to highlight a contiguous group of items. 

 
You can add the selected item(s) to the report in three ways: 

 Drag - When dragging into a list make sure that you see a triple 
vertical bar at your insertion point. Ctrl-click to select and insert 
multiple items at a time. When dragging near another object, a dark 
single bar on the left indicates that the object is placed above the 
existing object. A bar on the right indicates placement below the 
existing object. 

 Double-click – this inserts the object at the end of the list, or at the 
current cursor placement.  

 Right-click – first select the item, right-click and select Insert. 
Objects are inserted at the end of the list, or at the current cursor 
placement. 
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6. From the Account query subject, add the following query items to your 
report: 

 Account Number 
 Medium Title 

 
7. Expand the Object Code query subject and add:  

 Object Code 
 Medium Description 

 
8. From the General Ledger Details query subject, add: 

 Net Amount  
 Post Date 

 
Your report should look like this: 
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Changing the Column Order 

 
You can reorder columns in a report either by dragging and dropping the 
columns or by using the Cut and Paste functionality that you know from other 
programs. Now that you have seen the report layout, you decide you want to 
move Post Date before Net Amount. 
 

9. Highlight the Post Date column, and click on the Cut icon in the Toolbar. 
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10. The Post Date column disappears. Next, highlight the Net Amount column 

and click on the Paste  icon in the Toolbar. 
 

 
 

The Post Date column is inserted to the left of the selected column. 
 

 
 
Now let’s move the Medium Description column before the Object Code column.  
 

11. Highlight the Medium Description column and drag it to the left of Object 
Code. 
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Be sure to wait until you see a triple vertical bar on the left side of Object Code 
before dropping the Medium Description column into your report.  
 

 
 

12. Move the Medium Description column back to the right of Object Code. 
 
 
 
NOTE 

To more easily preview report data and layout, you can temporarily 
hide the Insertable Objects pane as shown below. Toggle the arrow 
a second time to show the tab again. 
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Deleting a Column 

 
13. Highlight the column you want to delete (Medium Title) then: 

 Click the Delete  icon in the Toolbar, or 
 Right-click on the column to find Delete in the shortcut menu, or 
 Select Delete from the Edit menu, or 
 Press the Delete key on your keyboard 

 
14. We didn’t really want to delete this column, so use one of the most useful 

functions in IBM Cognos – click the Undo  icon. If you make any 
mistakes, either before or after saving (as long as you haven’t already 
closed the query), the Undo feature works extremely well and saves the 
last 10 actions. 

 
 

Sorting Data 

 
You can sort data in ascending or descending, alphabetical, or numeric order. 
When sorting grouped data, you can sort the detail values or you can sort by the 
summary values in the footers.  
 
The default sort order in Business Insight Advanced is ascending order. You can 
sort by selecting multiple fields; however, the sort priority is from left to right 
where the leftmost column is sorted first.  
 

15. Click once in the Post Date column. 

16. Click on the Sort  icon in the Toolbar and select Ascending. 
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The report sorts on Post Date, and also displays the sort option in the column 
heading for Post Date. 
 

 
 

17. Select the Post Date column again. 
18. This time, open the Data menu, select the Sort option, and select 

Descending. 
 

 
 

19. To remove sorting, select Data > Sort > Don’t Sort. For now, change the 
sorting back to Ascending. 

 
 
 
NOTE 

The primary sort in Business Insight Advanced is the field furthest 
to the left of your list report. 

 
 
 
 
 



Chapter 3 – Creating a Simple List Report 
 

 51  

Saving a Report 

 

20. Choose Save or Save As  from the Report Actions  menu to 
save this report.  
 

 
 

21. Select My Folders and click OK.  
22. Navigate to your Business Insight Advanced Training folder and save 

the report specification as List.  
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NOTE 

When you save a report in Business Insight Advanced, you are 
actually saving the report specification: a set of instructions for 
extracting and formatting a particular set of data. You are not 
saving a “snapshot” of the data. You can, however, generate the 
report in another output option, i.e., PDF or Excel, and save it to 
another location in order to reflect the state of the data at a 
particular point in time. 
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Chapter 4 – Filtering Relational Data 
 
A simple list report typically displays rows and rows of detailed data that may or 
may not be terribly meaningful to the user. Most of the time, users want to narrow 
the data set by some sort of criteria, and remove redundant data by grouping and 
summarizing on similar data items.  
 
“Filtering” limits the report to include only the data that matches your criteria. 
 
 
Step-By-Step 
 

Filtering Data in Business Insight Advanced 

 
 
 
 

1. Start with your List report from Chapter 3. 
 

 
 

Before we run this report with actual data, let’s assume that we only want to see 
this information for specific accounts.  
 

2. We can add a Filter on a specific report item by clicking once in the 
column of the item by which you want to limit the data. Select the Account 
Number column. 
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3. Click on the Data menu, select Filters, and select Create Custom Filter. 
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The Filter Condition dialog box appears. This display varies depending on the 
type of data you are filtering. 

 When you filter on a numeric or date report item, you specify values, 
compare values, or identify a range of acceptable values (for example, 1 
to 5). 

 When you filter on a non-numeric, non-date column, such as Account 
Number (which is a character data type), you specify the particular values 
that are returned when the report is run.   

 

 
 

4. There are two different conditions available: either Show only the following 
values or Do NOT show the following values. Select Show only the 
following values. 

 

 
 

5. Type in “16000” as the Keyword, and click the Search down arrow to see 
that we are searching for values that start with 16000. Click Search. 
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6. Select all the values that are returned, and click the green arrow to move 
them into the Selected values panel. 

 

 
 

7. Click OK. 
 

  
 

You now have a filter applied to your report that limits the Account Number 
values. 
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Printing Reports 

 
To print the report, send the report to another output format, such as PDF or 
Excel, and print from that application. 
 

8. In the Run menu, select the Run Report - PDF option. 
 

 
 
The report opens in PDF format in IBM Cognos Viewer. You would click on the 

Print file  icon to print the report.  
 

 
 

9. Close IBM Cognos Viewer to return to Business Insight Advanced. 
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Let’s now add a combined filter on Net Amount and Post Date. We want to be 
able to select a specific value comparison on Net Amount when we run the 
report. Let’s also combine the Net Amount filter with an option to select a range 
for the Post Date. 
 

10. Click on the Filter icon in the Toolbar (the Toolbar icons offer alternatives 
to using the Menu options), and select Edit Filters. 
 

 
 

11. Click on the New icon to create a new filter. 
 

 
 

12. You have the option to create a filter on one data item or to create a 
combined filter. Select Combined and click OK. 
 

 
 

13. Select Net Amount and click OK. 
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14. Complete the Filter Condition to show only Net Amounts greater than 
$2,000. Click OK. 

 

 
 

15. In the Combined Filter dialog box, add a new filter. 
 

 
 

16. Select Post Date from the list and click OK. 
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17. For our Post Date filter condition, complete as shown so that the end user 
is prompted for a date range when the report is run.  

 

 
 

18. Select Dec 1, 2010 as the From value. 
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19. Select Dec 31, 2010 as the To value and click OK. 
 

 
 

20. Note that we now have a Combined Filter based on a Net Amount AND 
Post Date condition. When creating a combined filter, you have the option 
to select the operator. Selecting AND means that BOTH criteria must be 
met. Selecting OR means that either criterion could be met. Click OK twice 
to return to the report. 
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21. From the View menu, select Page Preview.  
 

 
 
Your report only displays data where the Post Date is in December 2010 and 
with a Net Amount greater than $2,000. 

 

 
 

22. Run the report using the Run Report – HTML menu selection to see the 
prompt you created on Post Date. Choose December 1 – 31, 2010 as your 
From and To date range in response to the prompt. 

23. Return to Edit Filters, select your combined filter, and click the Edit icon. 
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24. Select the AND operator and change it to OR. Click OK twice. 
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Note that your report now has additional records.  
 Your report now returns all Post Dates with Net Amounts greater 

than $2,000.  
 Click to the Bottom of the report to see that all December 2010 Post 

Dates return all Net Amounts. 
 

 
 
 
 
NOTE 

A Filter can be set up in the Framework Manager package if it is 
expected to be used frequently. You can drag the filter in from the 
Insertable Objects pane instead of setting up the filter as we just 
did. It can be designed to prompt the user every time the report 
runs. 
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Deleting a Filter 
 

25. We no longer want to limit the report by Net Amount. Remove the filter by 
navigating to the Data menu, Filters, Edit Filters. Highlight the combined 
filter, and click on the Edit icon.  
 

 
 

26. Highlight the Net Amount filter, click the Delete icon, and click OK twice.  
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27. From the Report Actions  menu, select Save As and save the report 
specification as Filter. 

 

 
 
 
 
NOTE 

To remove all filters, select Filters from the Data menu and select 
Remove all Filters. 
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Step-By-Step 
 

Additional Filtering Techniques 

 
 
 
 

1. Create a new report using the UCAR Training package by clicking on the 

New Report  icon in the Toolbar. 
2. Select List to create a new List report. 

 

 
 

3. From the View menu, select Page Design. 
4. From the CPM Training Data namespace, General Ledger namespace, 

Account query subject, add the following query items to your report: 
 Lab Code 
 Division_Program Code 
 Division_Program Medium Description 
 IFAS Fund Source Code 

 
5. From the Date query subject, add Fiscal Year to your report. 
6. From the General Ledger Details query subject, add Net Amount as your 

measure. 
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7. Sort Lab Code Ascending. 
8. Create a filter on Fiscal Year for Specific values for 2010. 

 

 
 

9. Return to your report, highlight the Fiscal Year column, and click Delete in 
the Toolbar. 

10. Open the Edit Filters dialog box again to see that the Fiscal Year filter is 
retained even though the column has been deleted. 
 

 
 
You now have a filter applied to your report without the extra column. 
 

11. Save the report specification as Additional Filtering Techniques. 
12. Change your View to Page Preview. 
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13. Highlight the IFAS Fund Source Code NASA. 
 

 
 

14. Click the Filter icon and select the option to Include NASA. This is another 
way to set up a filter condition. 
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Your report now returns records for Fiscal Year 2010 for the NASA fund only. 
 

 
 

15. Disable this latest filter by opening the Edit Filters dialog box and changing 
the Usage option to Disabled. Click OK. This may be a useful action when 
troubleshooting a report or exploring data. 

 

 
 

16. Save the report specification again (Additional Filtering Techniques). 
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NOTE 

You can paste text from other applications into type-in filters. You 
can also use wildcards to define filters. 

 
 
 
 
 
 
NOTE 

Using the Search for values in the Filter Condition dialog box allows 
for more flexibility in filtering. You can search and select multiple 
times before running a report. 

 

 
 
 





 

 73  

Chapter 5 – Grouping Data 
 
Grouping a report in Business Insight Advanced makes for a much more user-
friendly report by eliminating duplicate values and by displaying subtotals for 
each grouped item. You can organize the grouped data by row headings or by 
creating section headings.  

Creating a Grouped List Report 
 
Open the Filter report from the last chapter and note the duplicate values in the 
Account Number and Medium Title columns. 
 

 
 
When you group a report by query items, Business Insight Advanced: 

 Automatically sorts the rows in the report. 
 Eliminates duplication of the grouped row heading. 
 Creates a footer for each group and displays summarized values for 

those items where summarization is appropriate (measures). 
 Automatically moves the groups to the left of the report after existing 

groups. 
 
You cannot group by measures, such as Net Amount. You can only group report 
items containing text data or non-measure numeric data, such as Account 
Number. 
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Step-By-Step 
 

Grouping 

 
 
 
 
Let’s group our Filter report to improve its readability and to get summary 
information by accounts and object codes.  
 

1. Continue with your Filter report from Chapter 4. 
2. Save this report specification as Grouping. 
3. Set the View to Page Design. 
4. Click in the Account Number column and select the Group icon in the 

Toolbar. 
 

 
 

Notice the Group icon and Summary line added to the Account Number column. 
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5. Highlight the Medium Title, Object Code, and Medium Description 
columns (Ctrl-click), and click again on the Group icon. 

 

 
 

6. Run the report. Select December 1 – 31, 2010 as the date range. 
 

 
 
Notice the redundancy in the Summary lines when grouping the descriptions that 
follow the codes. 
 

7. Close IBM Cognos Viewer. 
8. Highlight the Summary lines for Medium Title and Medium Description and 

click on Delete in the Toolbar to remove the redundant summaries. 
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9. Set the View to Page Preview. Note that the grouped columns are now 
also sorted ascending. 

 

 
 

10. Save your report specification again (Grouping). 
 
Custom Groups 
 
Another way of grouping a report is to create Custom Groups that let you define 
detail values that are of specific interest to you. Your report presents results in a 
precise, controlled format. 
 
Let’s say we want to separate out fund source information for the CISL lab from 
all other labs. 
 
 
 
Step-By-Step 
 

Custom Groups 

 
 
 
 

1. Open the Additional Filtering Techniques report from Chapter 4. 
2. Set the View to Page Design. 
3. Save this report specification as Custom Groups. 
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4. Delete the Division_Program Code and Division_Program Medium 
Description columns. 

5. To create a custom group, click the Toolbox tab in the Insertable Objects 
pane. 
 

 
 

6. Drag a Query Calculation from the Toolbox to the beginning of the report. 
 

 
 



Chapter 5 – Grouping Data 
 

 78  

7. This opens a Create Calculation dialog box. Type “Custom Group” as the 
Name of the calculation, select Other expression (the other choices are 
options when working with dimensional data), and click OK. 

 

 
 

Creating a Calculation brings up the Data Item Expression definition window. 
Expressions can be used throughout Business Insight Advanced to enhance 
reporting. 

 
8. Complete the expression as shown and click OK. 

 

 
 
 
 

When defining expressions, ALWAYS drag query items from 
the Insertable Objects pane (either from the Source or the 
Data Items tab) into the window to avoid typing (user) errors! 

 
 
 
 
 

9. Group the Custom Group and Lab Code columns. 
10. Sort Net Amount descending. 
11. Save the report specification again (Custom Groups). 
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12. Run your report in PDF. 
 
Your report now contains a new column that groups the labs into two groups: 
CISL and Other with respective summary lines. 
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Chapter 6 – Aggregations and Calculations 
 
Grouping a report allows you to summarize the data in a variety of ways. One 
useful summarization type is Count. 
 
 
Step-By-Step 
 

Counting 
 
 
 
 
Let’s create a report to count the number of travel records within a three year 
range by Account Number. 
 

1. Create a new report using the UCAR Training package by clicking on the 

New Report  icon in the Toolbar. 
2. Select List to create a new list report. 

 

 
 

3. Set the View to Page Design. 
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4. From the Insertable Objects pane, CPM Training Data namespace, 
General Ledger namespace, Person query subject, add the following 
query items to your report: 

 Person Entity Identifier - PEID 
 Name 

 
5. From the Account query subject, add Account Number. 
6. From the General Ledger Details query subject, add the following: 

 Object Code 
 Document Id 
 Net Amount 

 
7. From the Date query subject, insert Fiscal Year before Account Number. 
8. Group on Person Entity Identifier – PEID, Name, and Fiscal Year. 
9. Delete the Summary line for Name. It is redundant with the Person Entity 

Identifier – PEID Summary. 
10. Sort ascending on Account Number. 
11. Add the following filters: 

 Custom filter for specific Person Entity Identifier - PEID values as 
shown here: 

 

 
 

 Custom filter for specific Fiscal Year values: 
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 Custom filter for specific Object Code all travel expense values that 
start with “54”. Note that the Select all only selects those elements 
on the visible list. You need to keep paging through to grab them 
all. 

 

 
 

12. Delete the Object Code column.  
13. Notice that deleting this column results in another Summary line added for 

Name. Delete that Summary line again. 
14. To create a count of trips, right-click on the Document Id column title and 

select Edit Query Expression. 
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The Data Item Expression window opens.  
 

 
 

15. Click on the Functions  tab to find a list of the expression-building tools 
that are available to report authors. 
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16. Highlight the count component as shown below to display the proper 
syntax in the Tips tab of the Information window. 

 

 
 

17. Drag the count expression from Available Components into the 
Expression Definition pane as shown, type in “distinct”, and close the 
expression with a parenthesis (or drag the closing parenthesis from the 
Operators folder): 
 

 
 

18. Click OK. 
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Business Insight Advanced automatically validates the expression. If there are 
any errors, it takes you back to the Expression Definition window. If the 
expression is correct, it returns you to your report. 

 

 
 

Your report design should look like this: 
 

 
 

19. Save your report specification as Count. 
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20. Click the Run Report  icon in the Toolbar and run your report in HTML.  
 

 
 

The Document Id column is now a count. Let’s add a Total count for Document 
Id.  

 
21. Close IBM Cognos viewer. Highlight the Document Id column, click the 

Summarize  icon, and select Automatic Summary (Total is not 
available). 
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22. Set the View to Page Preview and notice that summary values are added 
for our document count, but that they are not a total of the document 
counts for the Fiscal Year! 

 

 
 
 
 

The Automatic Summary option for summarizing data may 
not always produce the expected result in Business Insight 
Advanced. For our calculated count, the total is logically 
correct; it is simply doing a count distinct. In the circled 
example above, Document Id of TE116240 occurs twice – 
once for Account Number 150022 and again for 150954. 
Because of the count distinct, these are counted only once 
on the Summary line  

 
 
Let’s look at an alternative way to get a document count and total across 
accounts by fiscal year. 

 
23. From the Toolbox, drag a Query Calculation into your report to follow the 

Document Id column. 
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24. The Create Calculation dialog box opens. Name the calculation Unique 
Travel Record Count, choose Other expression, and click OK. 

 

 
 

25. In the Data Item Expression window, complete the expression as shown 
here, pulling Document Id from the Source tab, and click OK: 
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Notice that this new total count matches the previous total.  
 

  
 

26. Highlight the Unique Travel Record Count and Net Amount columns. Click 
the Summarize icon and select Total. Notice that a Total line has been 
added to your report with the total travel records count for each year 
across Account Number. 

 

 
 

27. Delete the Document Id column and all the Summary (not Total) lines. 
28. Delete the redundant Total line for Name. 
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Your report should look like this, with Totals for both the count and Net Amount. 
 

 
 

29. Save your report specification again (Count). 
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In Business Insight Advanced, you have the option to choose how you want IBM 
Cognos to aggregate your data.  
 
 
 
 
Step-By-Step 
 

Auto Aggregation 

 
 
 
 

1. Continue with your Count report. 
2. Click on the Filter icon and select Edit Filters. 
3. Let’s create another Custom filter based on Net Amount. 
4. Complete the Filter Condition as shown to limit the data returned to 

amounts greater than $500: 
 

 
 
 



Chapter 6 – Aggregations and Calculations 
 

 93  

Note that this filter is applied After auto aggregation. 
 

 
 

5. Review your report and notice that this filter has decreased the travel 
record count for Eddie Orr for 2009, for example, from 19 to 17. 
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6. Return to Edit Filters and set the Application of the Net Amount filter to 
Before auto aggregation. 

 

 
 

With the application of the filter before auto aggregation, it is being applied at the 
database record level and is therefore returning fewer records for each account. 
 

7. Save your report specification as Auto Aggregation. 
 
 
NOTE 

To further clarify this concept, when your filter is set to be applied 
Before auto aggregation, IBM Cognos filters the detail rows, then 
adds up the measure. When it is set to After auto aggregation, IBM 
Cognos summarizes the measure first, then applies the filter. 
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Some of the more advanced functionality in Business Insight Advanced includes 
the ability to add a calculated field. 
 
 
Step-By-Step 
 

Creating a Calculation 

 
 
 
 
Let’s set up a calculation that compares the Net Amount for Object Codes by 
Account Number. 
 

1. Open your Grouping report from Chapter 5. 
2. Delete the Medium Title and Medium Description columns. 
3. Right-click in the Net Amount column, choose Calculate from the shortcut 

menu, then select Custom to create a calculation. 
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4. Complete the Insert Custom Calculation dialog box as shown and click 
OK. Note that we are basing our % of Total on the Account Number. We 
also have the option to base our percentage on the overall total or Object 
Code, another grouped data item. 
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Business Insight Advanced inserts the new column into your report. 
 

 
 

5. Save your report specification as Calculation. 
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Chapter 7 – Report Design 
 
As you create and edit reports, you can enhance the appearance of your report 
by:  

 Formatting text and data 
 Editing titles 
 Formatting borders 

 
 
 
Step-By-Step 
 

Using a Template 

 
 
 
 

1. Still in Business Insight Advanced, click on the New Report  icon. 
2. Click on the Existing folder. 
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3. Navigate to Public Folders > IBM Cognos Training and open the 
Template report. 
 

 
 

4. Set the View to Page Design. 
5. From the CPM Training Data namespace, General Ledger namespace, 

Account query subject, add the following query items to the report: 
 Account Number 
 Medium Title 

 
6. From the Object Code query subject, add the following items to the report: 

 Object Code 
 Medium Description 

 
7. From the General Ledger Details query subject, add the following query 

items to the report: 
 Post Date 
 Net Amount  

 
8. Create a Custom Filter on Account Number to Show only 160001, 160002, 

and 160004. 
9. Create a Custom Filter on Post Date to Show only values between 

December 1, 2010 and Decemer 31, 2010. Check the box to Prompt for 
values when report is run in viewer. 

10. Click OK twice to return to your report. 
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11. Group the Account Number, Medium Title, Object Code, and Medium 
Description columns.  

12. Highlight the Summary Line for Medium Title and Medium Description and 
click Delete from the Toolbar to remove the redundant summary lines. 

13. Sort Object Code Descending. 
14. Save the report specification as Formatting. 
15. Run the report in HTML from the Toolbar. Enter December 1, 2010 to 

December 31, 2010 in the prompt page and click OK. 
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Your report has been created within a pre-designed template. 
 

 
 
 
 
Step-By-Step 
 

Formatting Data 

 
 
 
 

1. Highlight the Post Date column, right-click, and select Show Properties. 

2. In the Properties Pane, click on the  button under Data Format. 
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3. In the Data Format window, change the Format type from Default to Date.  
 

 
 
 
NOTE 

Other options for the Data Format include Text, Number, Currency, 
and Percent. These formats allow you to select how many decimal 
places to include, whether to “scale” the numbers, how to reflect 
negative numbers, and whether you want a comma separating the 
thousands. 

 
 

4. In the Properties, change the Date Style to Medium. Notice the Date Style 
information box that explains the different date formats available. Click 
OK. 
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5. Highlight the Net Amount column, and click on the Data Format  icon in 
the Toolbar. 

6. Change the Format type to Currency and change the number of decimal 
places to 2. Click OK. 

Editing Column Headings and Titles 
 
7. Highlight the Medium Title column heading. 

 

 
 

8. In the Properties Pane, click in the Data item label to edit the column title. 
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9. Type “Account Description” in the Data Item Label window and click OK. 
 

 
 

10. Change the Medium Description column heading to “Object Code 
Description”. 

11. To edit the title of the report: 
a. Click on the text box <Your Report Title Here> and edit the Text 

property, or 
b. Double-click on the text box and type “Account Postings”. 

 

 
 

12. Change the Sub-Title to “By Date Range”. 
13. Click OK. 
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Modifying Font Styles 
 
14. Highlight the Net Amount column in your report, and change the 

Foreground color to Blue in the Properties Pane. 
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15. Still in the Properties pane, change the Horizontal alignment to the right. 
 

 
 

The font styles options are also available in the Style Toolbar. 
 

 
 
 
 
 

16. Ctrl-click on the Summary row descriptions, select the Background Color 
icon in the Toolbar, and change the color to Yellow. 
 

 
 
 
 
 

17. Change the foreground color to Black. 
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Modifying Border Styles 
 

18. To change the borders around the summary row lines, Ctrl-click on the 
Summary row descriptions and the Summary Net Amount cells. In the 
Properties Pane, click on the ellipsis button under Border: 
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19. Change the Style to Solid Line, the Width to 2.25 pt, and the Color to 
Maroon. Apply the style to All Borders. Click OK. 

 

 
 

20. Run your report in HTML. (Select December 2010.) 
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The result is as shown here: 
 

 
 

21. Close the IBM Cognos Viewer to return to Business Insight Advanced. 
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22. From the Data menu, select Filters, Edit Filters, and review the filters in 
place. Click Cancel.  
 

 
 

23. Double-click in the text box next to the Filter icon on the page header and 
enter text as shown here describing the filters applied. Click OK. 
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Now the filters are displayed between the Title block and the List report. 
 

 
 

24. Save your report specification again (Formatting). 
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Chapter 8 – Additional Report Options 
 
Crosstabs are a very effective way to view typically aggregated (summarized) 
data in rows and columns. Generally speaking you analyze one or more 
measures across two or more dimensions. In this section we demonstrate the 
creation of 2 Dimension, 1 Measure crosstabs in Business Insight Advanced. 
 
 
Step-By-Step 
 

Crosstab Report with Count 

 
 
 
 
Let’s create a report to explore another way to view the count of travel records by 
Fiscal Year and Entity Code. 
 

1. Create a new List report with the UCAR Training package. 
2. Set the View to Page Design. 
3. From the CPM Training Data namespace, General Ledger namespace, 

Date query subject, insert the Fiscal Year query item into your report. 
4. From the Account query subject, insert the Entity Code query item into 

your report. 
5. From the General Ledger Details query subject, insert Object Code into 

your report. 
6. Click in the Object Code column, and create a filter to Show all values that 

start with “54” and insert them into the Selected Values pane. Note that 
the Select all only selects those elements on the visible list. You need to 
keep paging through to grab them all. 

7. Delete the Object Code column from the report page. 
8. From the Toolbox, drag a Query Calculation to the end of the report. 

Name the Calculation “Unique Travel Record Count”, and select Other 
expression.  

9. Complete the expression as shown here (pulling Document Id from the 
Source tab), and click OK. 
 

 
 

10. Set the View to Page Preview. 
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11. Click on the Entity Code column, and click the Pivot List to Crosstab icon. 
 

 
 

IBM Cognos creates a crosstab report as shown: 
 

 
 

12. Sort Fiscal Year Ascending. 
13. Sort Entity Code Ascending. 

Edit the Title of the report and type “Travel Record Count by Entity Code 
and Fiscal Year”. 

14. From the Toolbox, drag a Text Item into your header below the title and 
type a description of the filters: 
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15. Save your report specification as Crosstab – Count. 
16. Run the report in HTML. 

 

 
 

 
 
 
Step-By-Step 
 

Conditional Formatting 

 
 
 
 

1. Open the Crosstab – Count specification and save it as Conditional 
Formatting. 

2. Set the View to Page Design. 
3. Click in the crosstab measures area of the crosstab (check the Select 

Ancestor arrow in the Properties pane to be sure you have selected 
Crosstab Intersection.). 
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4. To access conditional formatting, 

 Click on the Conditional Styles  icon in the Toolbar, or 
 Select Conditional Styles from the Style menu 

 

 
 

5. In the Conditional Styles window, click on the New icon to create a New 
Conditional Style. 
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6. Select Unique Travel Record Count as the Data Item. Click OK. 
 

 
 
We want to differentiate the Unique Travel Record Counts in the intersections of 
the crosstab report by ranking them from lowest to highest. Let’s break down the 
Unique Travel Record Counts into three categories and associate each with a 
particular formatting style. 
 

7. Click on the New  icon to create a New Value. 
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8. Type “500” into the New value box, and click OK. 
 

 
 

9. Click on the New icon and create a New Value of “3000”. 

You can reposition the values by using the Up  and  Down arrows. 
 

10. For the bottom Style, select Poor from the drop-down box as shown here 
to give a Red background to those low values. 
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11. For the middle Style, click the Edit Style  icon to choose a Blue 
background and White foreground color. 

 

 
 

12. For anything above 3,000, select Excellent from the drop-down box. 
 

 
 

13. Click OK twice to apply the formatting.  
14. Save the report specification again (Conditional Formatting). 
15. Run your report. 
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Your report now highlights the highest counts in green and the lowest in red.  
 

 
 
 
It is often useful, and more illustrative, to view a graphic representation of your 
analysis. Users may find it easier to spot trends or relationships by reviewing a 
chart instead of a series of numbers. Business Insight Advanced provides a 
variety of chart types from which to choose when displaying data graphically.  
 
 
Step-By-Step 
 

Charts 

 
 
 
 

1. Continue with the Conditional Formatting report specification. 
2. Save this report specification as Page Layout and Chart. 
3. Click in the crosstab on the report page. 
4. Use the Select Ancestor arrow in the Properties pane to ensure you select 

the entire crosstab. 
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5. With the entire crosstab highlighted, click on the Chart icon and select 
More.  
 

 
 

6. Scroll through the different types of charts available. Click Cancel. 
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7. Back on the report page, in the Tools menu, select Options. 
 

  
 

8. Click on the Advanced tab, check the box next to Use legacy chart 
authoring, and click OK. This provides you access to create new reports 
using the legacy Report Studio charts instead of the default Business 
Insight Advanced charts. 
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9. Now click on the Chart icon in the Toolbar, select More, and review the 
charting options. Select the Donut with 3D Effects. Click OK. 
 

 
 

The Donut chart is inserted above the Crosstab report. 
 
Business Insight Advanced gives you the option to control page layout. Let’s 
create a layout to display both the chart and the crosstab on the same report 
page. 

10. Select the following page layout by clicking on the Page Layout  icon 
in the Toolbar: 
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11. Save your report specification again (Page Layout and Chart). 
12. Run the report in HTML from the Toolbar. 
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Step-By-Step 
 

Additional Chart Options 

 
 
 
 

1. Continue with your Page Layout and Chart report. 
2. Save the report specification as Charts. 
3. Click in the page body, click the Page Layout icon, and select the following 

page layout: 
 

 
 
A new column is inserted to the right of the existing Crosstab and Chart. 
 

4. From the Insertable Objects pane, Toolbox tab, drag a Chart into the new 
column.  

5. Choose a Column chart and click OK. 
6. Click in the new layout column, and align the chart Horizontal Center and 

Vertical Middle. 
7. Click on your new chart to display the drop zones. 
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8. From the CPM Training Data namespace, General Ledger namespace, 
General Ledger Details query subject, drag the Person Entity Identifier - 
PEID query item into the Categories (x-axis). 
 

 
9. Create a new Custom Filter on Person Entity Identifier – PEID to Show 

only 011337, 023818, and 047192. 
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NOTE 

The Categories (x-axis), Default measure (y-axis), or Series 
(primary axis) drop zones do not appear until you drag a query item 
over the empty chart or click into the chart. 

 
 
 
 

10. From the Object Code query subject, drag the Object Code query item into 
the Series (primary axis). 
 

 
 

11. Create a Custom Filter on Object Code to Show only values starting with 
“54”.  

12. Delete the Object Code from the Series. 
13. From the Date query subject, drag Fiscal Year into the Series. 
14. From the General Ledger Details query subject, drag Net Amount into the 

Default measure (y-axis) area of the chart.  
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15. Set the View to Page Preview. 
 

 
 

16. Sort Fiscal Year Ascending. 
17. From the Insertable Objects pane, Toolbox tab, drag a Block into the right 

column of the report page, and drag the Chart below the Block. 
18. Drag a Text item into the Block, type in a title for the report, and click OK.  

 

 
 

19. Change the Font size to 18. 
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20. Run the report in HTML.  
 

 
 

We decide we want to switch this new chart’s style. Close IBM Cognos Viewer. 
 

21. Right-click in the chart, and select Convert Chart. 
 

 
 

22. Select the Stacked Bar with 3-D Effects chart style and click OK. 
23. Save the report specification again (Charts). 
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NOTE 
 

Hover the mouse over each of the bars to view the detail. 
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Chapter 9 – Examining a Report with Dimensional Data 
 
In this chapter, we get acquainted with the Business Insight Advanced interface 
for reports with dimensional data by viewing an existing report.  
 
 
 
Step-By-Step 
 

Examining a Report with Dimensional Data 

 
 
 
 
First we again make a copy of the original report and save it in My Folders. 
 

1. Navigate in Public Folders to the Budget Summary Report (Public 
Folders > IBM Cognos Training > Business Insight Advanced 
Training > Chapter 9 > Budget Summary Report). 

 

 
 

2. In the Actions menu, click on the More link. 
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3. From Available actions, click on Copy. 
 

 
 

4. Navigate to your Business Insight Advanced Training folder in My Folders 
and click OK twice. 

 

 
 

5. Navigate to this new Copy of Budget Summary Report and launch 
Business Insight Advanced by clicking on More in the Actions Menu and 
selecting Open with Business Insight Advanced. 
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6. Explore the user interface. 
 
 

 
 
 

 
 
 
 
 
 
Much of the interface is familiar from our work with reporting on relational data. 
We will look at the Page layers and Context filters areas in more depth in the 
following chapters as we work with dimensional data. 
 

Source 
Tree 

Work 
Area

Properties 
pane 

Page 
navigation 

Page 
layers 

Context 
filters area 

Insertable 
Objects 

pane

Drop Zones 
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7. Notice the icons at the top of the Insertable Objects pane. Hover over 
each one to see its purpose: 

 

 
 

8. Click on the View Members Tree and View Metadata Tree icons to see 
how they change the view of the Insertable Objects. 

 

 
 
We will work more with members, sets, and external data in later chapters. 
 
 
 
NOTE 

Why do some dimensions have folders while others do not? 
Folders can be used to organize dimensions, or can signify that 
there is an “alternate drill path” for a particular dimension. You 

cannot drag a dimension folder or the Measures folder  
into a Business Insight Advanced report. You must select from one 
of the drill paths contained within those folders. 
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9. In the Source tab, click on the Expand arrow next to the TM1 Cube Data 
folder, and navigate to the TM1 Cube Data Training folder, Financials 
Exploded Report Training folder, cd_Fund Source folder. Continue to 
expand the Fund Source dimension to view this dimensional hierarchy.  
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10. Right-click on various members in the tree to view their properties. 
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The Page layers area shows the dimension and members of that dimension on 
which the report is displaying page breaks. Values for each member display on a 
separate page. 

 

  
 

11. Use the Page navigation to Page up and down to see the report for the 
different labs. 
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12. In the Context filters area, you can also easily explore and change the 
contents of the analysis. Specific data items in this area filter your report to 
show values, or context, only for that data item. This is an easy way to 
apply a filter to your report without adding it to your report view (Work 
area).Click on the All Months context filter and select Oct YTD to change 
the values in the report.  
 

 
 

13. Click Undo  to return to All Months. 
14. Click on the Div 20 Keys Rollup context filter to see the options available. 

Expand the Insertable Objects cd_Account dimension to get a better 
picture of their meaning. 
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15. Click on the All Years context filter. Select Search so that we can look at 
2010 values. 

 

 
 

16. Complete the Member Search dialog box and click Search. 
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The member 2010 displays in the Insertable Objects Search tab. 
 

  
 

17. Drag 2010 to replace the All Years context filter: 
 

 
 

Notice the context filter, the report values, and the report header have changed 
to reflect the new selected member. 
 

 

 



Chapter 9 – Examining a Report with Dimensional Data 

 141  

 
 
NOTE 

Changing the focus of a context filter changes the data item values 
in a report. It does not limit or change the items in the rows or 
columns. Members that are used as a context filter appear in the 
report header when you run the report. 
 

 
 

18. Let’s expand the 2010 context filter one more time and select the option to 
prompt for this hierarchy when the report is run: 

 

 
 

19. To view your prompt, run your report in HTML, expand the All Years 
hierarchy, and select 2011 in response to the prompt. 

20. Return to your report. Save your report specification as Analysis. 
 

 





 

 143  

Chapter 10 – Creating a Simple Analysis 
 
 
Step-By-Step 
 

Creating a Simple Analysis 

 
 
 
 
Let’s create a budget summary report using the financials dimensional data. 
 

1. Create a new Crosstab report based on the UCAR Training package. 
 

 
 

2. Set the View to Page Design. 
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3. Expand the TM1 Cube Data folder, Financials Exploded Report Training 
folder, cd_Scenario folder. Drag the IFAS Funds Available member to the 
Columns drop zone. 

 

 
 

Notice we are inserting the IFAS Funds Available member with its children as a 
set, the default in Business Insight Advanced. 
 

 
 

4. Highlight the Rows drop zone, expand the cd_Object folder and navigate 
to the All Expenses member in All Revenue and Expenses. 

 

  
 

5. Right-click and select Insert to insert All Expenses as the rows in your 
report. 
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6. Expand the cdm_Financial Exploded measures folder, Total MTDC 
measure, and drag Amount into the Measures drop zone.  

 
Your report should look like this: 
 

  
  
Remember that we need to select from the remaining dimension folders to filter 
the data correctly. We select those dimensions and insert them as context filters. 
 

7. Drag over the following members as context filters: 
 From the cd_Month folder, All Months 
 From cd_Budget Type, All Budget Types 
 From cd_Account, Div 20 Keys Rollup 
 From cd_Fund Source, All IFAS Fund Sources 

 
8. Let’s drag 2011 from the cd_Year level, insert is as a context filter, and 

create a prompt so that end users can choose the year of interest when 
they run the report. 

 

  
 

9. Edit the report title to read “Budget Summary Report”. 
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10. Save the report specification as Suppression. 
11. Set the View to Page Preview. 
12. Run your report in HTML. Choose 2011 in response to the prompt. 

 

 
 

 

Drilling Up and Down 

In Business Insight Advanced 
 
There are a number of ways to quickly change the focus of your analysis by 
drilling up and down through the levels of your data. Drilling allows the user to 
examine the organization’s performance at a very high level, and then explore 
more and more of the detail in order to isolate specific issues and answer specific 
questions. Business Insight Advanced allows drilling in either the rows or 
columns of the crosstab, or on both rows and columns simultaneously. 
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13. Close IBM Cognos Viewer to return to the report page. 
14. Click on the Benefits cell to see the link that indicates that we can drill, and 

click on that link. 
 

 
 

15. Double-click on Full Benefits – Applied to see that you have reached the 
lowest level in the dimension. Click on the summary row links to return to 
the All Expenses view. 

16. Double-click on the IFAS Encumbrance column header cell to drill down 
through the levels. 

17. Right-click on the summary column header and select Drill Up twice to 
return to our original IFAS Funds Available view. 
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18. Highlight the All Expenses summary row, right-click, and select Drill Up.  
 

 
 
This displays the next level up in the cd_Object dimension. 
 

 
 

Note that this All Revenue and Expenses is the highest level member in the 
cd_Object drill path.  
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Next we drill down using both a column and a row to filter the data. 
 

19. Highlight the cell at the intersection of All Expenses and Incurred Actual. 
Click the link. 

 

 
 
Your report should appear as follows: 
 

  
 

20. Click Undo to return to the previous view. 
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In IBM Cognos Viewer 
 
You must choose to allow drilling in a report when run in IBM Cognos Viewer. 
 

21. In the Data menu, select Drill Options. 
 

  
 

22. Allow drill-up and drill-down and click OK. 
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23. To demonstrate the differences between drilling in IBM Cognos Viewer 
versus Business Insight Advanced, run your report in HTML. (Select 
2011.) 

 

 
 

24. Click on the All Expenses link. 
 
Note that there is not an option to drill up from the Row or Column summary 
cells.  
 

 
 

25. Click on the Salaries link, then the Salaries – Other Scientists link to drill 
down two more levels. 
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26. Since there is again not a live link, drill up by right-clicking on the Salaries 
– Other Scientists row, and selecting Drill Up. 

 

 
 

27. Drill up again by highlighting any of the Salary rows, and clicking on the 
Drill Up icon in the Toolbar until you return to our original report. 

 

 
 

28. Click on the IFAS Encumbrance link to drill down in the columns. 
29. Highlight a column summary cell, right-click, and click on the Drill Up to 

move back up a level.  
 

 
 

30. Close IBM Cognos Viewer to return to Business Insight Advanced. 
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Suppression 
 

31. Drill down on All Expenses to return to the original view of our report. 
 
Note that the several rows have null values, so we would like to eliminate them 
from this view of our Analysis. 
 

32. From the Toolbar, click on the Suppress  icon, and select Suppress 
Rows and Columns. 

 

 
 

Notice that no message is added to the report to indicate that Suppression is 
applied. The report summary for All Expenses amount stays the same. 
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NOTE 
 

You can also suppress from the Data menu. Note the options to 
apply Suppression. Calculations are performed before 
suppression is applied. 
 

  
 

      
 

33. Save your report specification again (Suppression). 
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Chapter 11 – More Analysis Techniques 
 
 
Step-By-Step 
 

Changing Rows, Columns, and Measures 

 
 
 
 
The flexibility to change any or all of the objects in a Business Insight Advanced 
report easily gives users the ability to compare and analyze any number of 
different combinations of factors or views of the organization. Let’s look at salary 
details. 
 

1. Create a new Crosstab report based on the UCAR Training package. 
2. Set the View to Page Design. 

3. Hover over the  icons at the top of the Insertable Objects pane to 
see that we are inserting sets and members with children. 

4. Expand the TM1 Cube Data folder, TM1 Cube Data Training folder, 
Employee Plan to Actual Report Training folder, cd_Scenario folder. Drag 
the Working Plan vs Actual Variance member to the Columns drop zone. 

5. Expand the cd_Employee folder, and drag UCAR All to the Rows drop 
zone. 

6. Expand the cdm_Employee Plan to Actual measures folder, and drag 
Amount to the Measures drop zone. 

7. From the Insertable Objects pane, drag over the following members as 
context filters: 
 From cd_Budget Type, All Budget Types 
 From cd_Object Employee, All Salary-related Expenses 
 From cd_Fund Source, All IFAS Fund Sources 
 From cd_Date, 2011 
 From cd_Account, All Accounts 
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8. Highlight the Page Body of your report (confirm your selection by checking 
the Select Ancestor arrow at the top of the Properties pane), and in the 
Properties pane, change the Horizontal alignment to Center.  

 

 
 

9. Save this report specification as Changing Rows, Columns, and 
Measures. 

10. Change to the Page Preview view and review your report. 
 
Let’s exclude the Sample HR Org from the report, since it has no data. 
 

11. Highlight the Sample HR Org cell, click on the Data menu, and navigate to 
Explore, Exclude Members, From Current Set. 
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Your report should now look like this: 
 

  
 

Selection Sets 
 
Another way to change your analysis is to create a set by explicitly selecting 
items from the Cube. Sets can contain items from any level within the dimension. 
 
Let’s compare inserting members individually versus members as sets. 
Remember that Business Insight Advanced inserts members as sets by default. 
You can see in the report above that all of the UCAR All members are highlighted 
as one set. 
 

12. Navigate to the  icon at the top of the Insertable Objects pane and 
toggle it to insert individual members. 
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13. From the cd_Employee folder, expand UCAR All and NCAR members.  
 

 
 

14. Ctrl-click CISL, RAL, and NESL. Drag them to the Rows drop zone, 
making sure to replace all the rows indicated by the dark block. 

 

 
 

15. Run your cursor over the row header cells to see that they stand 
individually and cannot be selected as a set. 
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16. Ctrl-click the three members, click on the Explore  icon (a shortcut for 
the Explore selection in the Data menu), and navigate to select Union 
into One Set and Keep Duplicates. 

 

 
 

17. You can now select the rows as a set. Highlight the row header cells and 
in the Properties pane, change the Font to Italic Bold: 

 

 
 
Let’s next change the columns. 
 

18. From the cd_Scenario folder, expand the Working Plan vs Actual Variance 
member and drag Incurred Actual into the Columns drop zone (again be 
sure to replace all the columns as indicated by the dark block). 

 
Our analysis would be even more useful if we could see both Amount and Hours 
together. 
 

19. From the cdm_Employee Plan to Actual measures folder, Ctrl-click 
Amount and Hours, and drag them both to the Measures drop zone. 
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Your report should now look like this: 
 

  
 
You have now changed the rows, columns, and measures of your original report. 
 

20. Save your report specification again (Changing Rows, Columns, and 
Measures).  
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Chapter 12 - Applying Filter Conditions with 
Dimensional Data 

 
 
We have essentially been “filtering” or limiting the amount of data returned in our 
reports thus far in a number of ways by using the basic functionality available in 
Business Insight Advanced: 
 

 Drilling up and down to focus on different views.  
 Using context filters. 
 Using the Search function.  
 Selecting members from different levels from the Insertable Objects. 
 Using Suppress.  

 
Additional filtering options in Business Insight Advanced include: 
 

 User-defined filters.  
 Editing a set. 

 
 
 
Step-By-Step 
 

Applying a User-Defined Filter 

 
 
 
 
Let’s examine salaries above a specific threshold. 
 

1. Continue with your Changing Rows, Columns, and Measures report 
from Chapter 11. 

2. Save this report specification as Filtering with Dimensional Data. 
3. Navigate to the TM1 Cube Data, TM1 Cube Data Training, Employee Plan 

to Actual Report Training, cd_Employee, All Employees member. 
4. Drag All Employees into the Rows drop zone. 
5. Suppress the rows and columns. 
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Your report should look like this: 
 

  
 
Next, assume we only want to see employees who have worked more than 1600 
hours in the year. 
 

6. Navigate to Edit Filters, and create a custom filter based on Hours: 
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7. Keep the Comparison option, and type “1600” as the Value.  
 

 
 

8. Click OK twice. 
 
The report is filtered, but note that the summary values remain the same. 
Although we are filtering the employees from the report view, the overall 
summary values are not affected. 
 

 
 
 
 
NOTE 

To add a summary line for only the employees who worked over 
1600 hours, click on your new set, click on the Summarize icon in 
the Toolbar, and select Total. 
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Editing a Set 
 

Business Insight Advanced provides the ability to filter a report by editing a set.  
 

9. Change the View to Page Design. 
10. Open Edit Filters and disable the Hours filter. 

 
 

 
 

11. Highlight the row title cells, right-click, and select Edit Set. 
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12. Select the New icon to add a new filter to the set. 
 

  
 

13. Complete the Set Filter Condition dialog box as shown: 
 

 
 

14. Click OK three times to return to the report. 
15. Set the View to Page Preview. 
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Your report now displays data for all employees except those with “TM” in the 
caption. 
 

  
 

16. Save your report specification again (Filtering with Dimensional Data). 
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Chapter 13 – Advanced Techniques and Reports 
 

 
Thus far, we have been drilling down to view different levels within dimensions 
individually. At times, users may want to view and group multiple levels in a 
hierarchy, multiple sets, or multiple measures simultaneously together on the 
same report.   
 
 
Step-By-Step 
 
 

Nesting 
 
 
 
Let’s set up a Contract Status Detail report that we can filter by lab. 
 

1. Create a new Crosstab report based on the UCAR Training package. 
2. Set the View to Page Design. 

3. Hover over the  icons at the top of the Insertable Objects pane to 
see that we are inserting sets and members with children. 

4. Expand the TM1 Cube Data folder, TM1 Cube Data Training folder, 
Financials Exploded Report Training folder, cd_Scenario folder. Drag the 
IFAS Funds Available member to the Columns drop zone. 

5. Drag the cd_Contract level to the Rows drop zone. 
6. Expand the cdm_Financial Exploded measures folder, Total MTDC 

measures,and drag Amount to the Measures drop zone. 
7. From the Insertable Objects pane, drag over the following members as 

context filters: 
 From the cd_Year level, 2011 
 From cd_Month, All Months 
 From cd_Budget Type, All Budget Types 
 From cd_Account, All Accounts 
 From cd_Object, All Revenue and Expenses 
 From cd_Fund Source, All IFAS Fund Sources 
 From cd_Lab, EOL – Earth Observing Lab 

 
8. Suppress rows and columns. 
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9. Set the EOL context filter to be a prompt. First select Prompt on 
Hierarchy, then return to select Single Value – we only want to report on 
one lab at a time. 

 

  
 

10. Sort the contracts ascending by label. 
 

  
 

11. Save your report specification as Nesting. 
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12. Set the View to Page Preview. 

 

 
 

13. Return to the Page Design view. 
14. From the cd_Account folder, drag All Accounts into your report and “nest” 

them in your rows. Look for the flashing bar. 
 

 
 

15. Delete the All Accounts context filter, since we have moved that dimension 
into the report. 
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16. Return to Page Preview to see the results. 

 

 
 
Note that all the Accounts are now nested under each Contract. Note that the 
Accounts belonging to each Contract are listed and have been subtotaled. 
 

17. Click the Swap Rows and Columns  icon to see that this feature works 
with nested columns as well as rows. 

 

 
 
18. Click Swap Rows and Columns again to get back to the original view (or 

click Undo ). 
19. Let’s assume that we originally were really only interested in accounts 

beginning with 7402. Let’s delete the level as shown below. Right-click 
one of the All Accounts row header cells and select Delete. Do the same 
for the All Accounts summary line. 
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20. This time, instead of selecting All Accounts from the cd_Account folder, 
right-click on All Accounts, and select Search. Type “7402” in the Member 
Search dialog box, keep Starts with any of these keywords, and click 
Search. 

 

 
 
The results of your search are displayed in the Search tab in the Insertable 
Objects pane. 
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21. Shift-click to select all of the 7402 accounts and nest them into our report 
rows. 

 
Your report should now look like this: 
 

 
  
The report now has nested only the members belonging to the accounts starting 
with 7402. 
 

22. Again delete the nested rows and let’s examine our data from a different 
perspective. 

23. Drag All Accounts from Insertable Objects pane to the end of the Rows 
drop zone and find the flashing bar. 

24. Add yet another level of complexity by nesting both Amount and Total 
MTDC Excl as measures. In Insertable Objects, in the Financials 
Exploded Report Training folder, expand the cdm_Financial Exploded, 
Total MTDC folder. Ctrl-click the Amount and Total MTDC Excl measures 
and drag them to the bottom of the Columns drop zone until you find the 
flashing bar. 
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Your report now has nested rows and columns. Note that the default measure, 
Amount, is shown in the upper left corner.  
 

 
 

25. Save your report specification again (Nesting). 
 

 
 
Step-By-Step 
 

Calculations 

 
 
 
 
Let’s take a brief look at calculations with the UCAR Training package, TM1 
Cube Data.  
 

1. Create a new Crosstab report based on the UCAR Training package. 
2. Set the View to Page Design. 

3. Hover over the  icons at the top of the Insertable Objects pane to 
see that we are inserting sets and members with children. 

4. Expand the TM1 Cube Data folder, TM1 Cube Data Training folder, 
Financials Exploded Report Training folder, cd_Object folder. Drag the All 
Revenue and Expenses member to the Columns drop zone. 

5. Drag the cd_Entity level to the Rows drop zone. 
6. Expand the cdm_Financial Exploded measures folder, Total MTDC 

measures, and drag Amount to the Measures drop zone. 
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7. From the Insertable Objects pane, drag over the following members as 
context filters: 

 From cd_Scenario, IFAS Funds Available 
 From the cd_Year level, 2011 
 From cd_Month, All Months 
 From cd_Budget Type, All Budget Types 
 From cd_Account, All Accounts 
 From cd_Fund Source, All IFAS Fund Sources 

 
8. Suppress rows and columns. 

 
Your report should look as follows: 
 

 
 

9. Change the View to Page Preview. 
 

 
 

Business Insight Advanced provides the capability to perform simple calculations.  
 

10. Ctrl-click to highlight the two column title cells: All Revenue and All 
Expenses. 
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11. From the Data menu, select Calculate, % Difference (All Revenue, All 
Expenses). Note the other calculation options. 

 

 
 
Notice that Business Insight Advanced adds the new calculated column to your 
report. 
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NOTE 

When you Ctrl-click items from the Insertable Objects pane, the 
column you choose first displays first. This is also true for 
calculations when you Ctrl-click columns in the Work area. 

 
 
 

12. Sort the analysis by All Revenue and Expenses by clicking in the Column 
title cell, clicking on the Sort icon in the Toolbar, and then selecting Sort 
by Value, Descending. 

 

 
 

 
 

13. Save your report specification as Calculating with Dimensional Data. 
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Step-By-Step 
 

Viewing Data Graphically with Charts 

 
 
 
 
 
Let’s look at salary information by entity.  
 

1. Create a new Crosstab report based on the UCAR Training package. 
2. Set the View to Page Design. 

3. Hover over the  icons at the top of the Insertable Objects pane to 
see that we are inserting sets and members with children. 

4. Expand the TM1 Cube Data folder, TM1 Cube Data Training folder, 
Employee Plan to Actual Report Training folder, cd_Scenario folder. Drag 
the Working Plan vs Actual Variance member to the Columns drop zone. 

5. Expand the cd_Employee folder, and drag UCAR All to the Rows drop 
zone. 

6. Expand the cdm_Employee Plan to Actual measures folder, and drag 
Amount to the Measures drop zone. 

7. From the Insertable Objects pane, drag over the following members as 
context filters: 
 From cd_Budget Type, All Budget Types 
 From cd_Object Employee, All Salary-related Expenses 
 From cd_Fund Source, All IFAS Fund Sources 
 From cd_Date, 2011 
 From cd_Account, All Accounts 

 
8. Suppress rows and columns. 
9. In the Tools menu, Options, Advanced tab, be sure the Use legacy chart 

authoring option is unchecked. 
10. Save your report specification as Charting with Dimensional Data. 
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11. Change the View to Page Preview. 
 

 
 

12. Click the Insert Chart  icon and select Column Chart. 
 

 
 

The chart is added to the Work area. 
 

 
 



Chapter 13 – Advanced Techniques and Reports 

 179  

 
13. Click the Page Layout icon, and select the following layout: 

 

 
 

Now our chart and crosstab are side-by-side and at the top of the page for easier 
viewing, particularly when we run the report in IBM Cognos Viewer. 
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14. Double-click on UCAR in the chart legend to drill down a level. 
 

 
 

 
 
Note that drilling in the Chart is not also reflected in the Crosstab (and vice 
versa). 
 

15. Right-click on UCAR in the chart legend and select Show Values. 
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16. Complete the Show Values dialog box as shown here:  
 

  
 
Now your chart shows each column’s value. 
 

  
 

17. Click on a bar in the chart and note the change in focus in the Properties 
pane. 

18. Open the Properties pane, and select the Combination Chart using the 
Select Ancestor arrow. Scroll down to see the options available for your 
use in tailoring a chart. 
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19. Click on the Trendlines ellipsis. 
 

 
 

20. Add a new linear trendline to your chart. 
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21. Explore some of the other chart options. Click the Undo  arrow when 
done with each action. 

22. With the focus on the Combination Chart, change the Legend property 
from Top Right to Align Middle Right: 
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23. Right-click on your chart, and select Update Chart from Crosstab. This 
allows you to drill back up to the UCAR All level. 

 

 
 

24. From the Data menu, select Drill Options, and check the box to allow 
drill-up and drill-down. 

25. Add a title to your report: “Salary Information by Entities”. 
26. Save your report specification again (Charting with Dimensional Data). 
27. Run your report in HTML in IBM Cognos Viewer. 

 

 
 

28. Explore the expanded chart drill capabilities offered in IBM Cognos 
Viewer. Be careful not to drill down to the individual employee level! 
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Chapter 14 – Advanced Functionality 
 
Business Insight Advanced includes the ability to supplement the data in your 
package with external data. This allows you to bring a spreadsheet of your 
personal data into IBM Cognos to create reports.  
 
When you import your external data into a package, you are creating a new 
package that includes the original data, the new external data, and any links or 
relationships that you define between the two. After importing the file into an 
existing IBM Cognos package, you can create reports from both your data and 
the package data. 
 
The following type of files can be imported: 

 Microsoft Excel (.xls) files 
 Tab-delimited text (.txt) files 
 Comma-separated (.csv) files 
 XML files 

 
 
NOTE 

Before importing your own external data file, your IBM Cognos 
administrator must grant you permission for the Allow External 
Data capability found within the Report Studio captability.  

  
 
 
*** Please watch the instructor do this exercise. 
 
Demo 
 

Integrating External Data 

 
 
 
 

1. Start with your Filter report from Chapter 4. Ensure that the View is set to 
Page Design. 

2. Prepare your external data for import. 
3. Navigate to the CPM Training Data namespace, General Ledger 

namespace, Object Code query subject, and right-click on the Object 
Code query item.  
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4. Select Lineage from the shortcut menu to view the properties for the 
Object Code. 

 

  
 

5. Click on the Technical View tab and note the Datatype is Character 
Length 16. 
 

 
 

To successfully work with external data, verify that your external data matches 
your enterprise data for reporting needs. For example, when bringing in 
supplemental information about State Bar Members, be sure that a field (such as 
State Bar Member#) matches the formatting used in your enterprise data source. 
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6. Navigate to the Object Code Type CSV file and make sure to save a copy 
where you can locate it. 

 
 
NOTE 

The maximum file size that can be imported into IBM Cognos is 2.5 
MB, with a maximum of 20000 rows. Comma-separated (CSV) files 
are the most reliable file type to import. 

 
 
 

7. Click on the Managed External Data  icon in the Insertable Objects 
pane. 
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A step-by-step wizard opens that guides you through importing external data. 
 

 
 

8. Click on the Browse button, navigate to the Object Code Type file, and 
click Open. 

9. Business Insight Advanced imports the file and lists the Data Items from 
the external file. Select All. 
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10. Leave the Namespace for the external data as Object Code Type. Click 
Next. 
 

 
 

11. In the Data Mapping window, note that the Object Code Type query 
subject is being created with two query items: Object Code and Code 
Type. Click Next. 
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12.  In Data Attributes, change the Data type for Object Code to Text and click 
Next. 
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13. In Mapping Options, leave the settings in their defaults and click Finish. 
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In the Manage External Data window, notice that our Object Code Type 
namespace has been created and that our new package appends “External 
Data” to the original package name. 
 

 
 

14. Click on the ellipsis next to the new package to see that the package is 
automatically published in My Folders.  
 

 
 

15. Cancel to exit out of the Save As window, then click Publish. 
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16. The Business Insight Advanced wizard warns that the external data we 
are uploading is relational and cannot be mixed with dimensional data in 
the same query. Click OK. 
 

 
 

17. After Business Intelligence Advanced publishes the package, you should 
get a notification that the report specification is valid. Click OK to return to 
your report. 
 

 
 

Note the message in the Insertable Objects pane stating that the new package is 
available: 
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18. Select the following page layout from Page Layout  icon from the 
Toolbar. 
 

 
 

19. Drag the existing List report into the bottom left section of the report page. 
20. With the entire List selected, click on the Chart icon and add a Bar Chart 

to your report page. 
21. Drag the new chart into the bottom right section of the report page. 
22. From the Toolbox, drag a new List report into the top section of the page. 
23. From the Training External Data package, Object Code Type namespace, 

Object Code Type query subject, drag the Code Type query item and the 
Object Code query item into your new query. 
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24. Run your report from the Toolbar. (Select December 1, 2010 to December 
31, 2010.) 
 

 
 

25. Save your report specification as External Data. 
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Demo 
 

Extending a Business Insight Advanced Report 
in Report Studio 

 
 
 
If you require additional functionality, or prefer to work in Report Studio, open the 
report in Report Studio.  
 

1. In Public Folders, navigate to Public Folders > IBM Cognos Training > 
Business Insight Advanced Training > Chapter 1 > Account Postings 
by Date Range, and click on the More link in the Actions Menu.  
 

 
 

2. Click on the Open with Report Studio link. 
 

 
 
IBM Cognos opens the query in Report Studio, maintaining all of the existing 
filters, formatting, and other specifications. You may then use Report Studio to 
revise and refine the query as you choose. 

 
3. From the Insertable Objects pane, Toolbox tab, drag a Layout Calculation 

into the page header. 
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4. In the Report Expression window, complete the expression as shown: 
 

 
 

5. Run your report in HTML (Select December 2010).  
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Your report displays with the date range selected in the prompt: 
 

 
 

6. Save your report specification as Report Studio.  
7. Close the report and launch Business Insight Advanced from IBM Cognos 

Connection. 
8. Select the UCAR Training package. 
9. Select to Open existing, and open your Report Studio report. 

10. Set the View to Page Design. 
 

 
 

11. Notice that the Layout Calculation created in Report Studio is still present, 
but that you cannot edit the calculation in Business Insight Advanced. 
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Reports edited in Report Studio can still be modified in Business Intelligence 
Advanced, but the elements added to the report that are specific to Report Studio 
cannot be changed in Business Insight Advanced. 

 
12. Run the report in HTML (select December 2010). 

 

 
 
 
 
NOTE 

Your organization must have granted access to Report Studio in 
order for you to use it.  
 
 
 
 
 

 
 
NOTE 

Run options only apply when you run an analysis in IBM Cognos 
Viewer or open it in Report Studio. 
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Drill-Through 

 
If drill through has been set up from the cube, you can drill down to a related 
detail report from Business Insight Advanced. 
 
The instructor will discuss this feature. 
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NOTES 
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